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¿Qué es Mendeley? 

Mendeley es un gestor de referencias bibliográficas 

gratuito que combina una versión web con una versión de 

escritorio, incorporando funcionalidades de la Web social. 

Permite: 

• Importar documentos y organizarlos en la biblioteca 

personal 

• Compartir y colaborar con otros investigadores 

• Incluir citaciones a documentos de texto y generar 

bibliografías  

• Crear un perfil personal con el currículo, publicaciones, 

filiación, etc.  

 



Accesible desde….. 

• Software gratuito 

• Multiplataforma 

(Win/Mac/Linux) 

• Apps para iPhone, iPod 

Touch and iPad y ahora 

para Android, permitiendo 

mantener sincronizadas 

todas las versiones, 

escritorio, web y móviles 

Escritorio  

Web  

Móvil 



Mendeley Institutional 

Edition en el CSIC 

Versión institucional (MIE) del gestor con grandes 

ventajas respecto a la versión gratuita:  

 Funcionalidad Versión gratuita MIE 

Almacenamiento 2 GB 5GB 

Nº de Grupos de trabajo privados 1 Ilimitado 

Usuarios por grupo 3 Hasta 25 

Almacenamiento en grupos de trabajo 100 MB 20 GB 

Métricas de impacto de publicaciones propias No Sí 

Recomendaciones de artículos a partir de su biblioteca personal con  

Mendeley Suggest 

Sí (versión Beta) Sí 

Acceso a los textos completos de documentos existentes en Mendeley 

que se encuentren en revistas suscritas por el CSIC  a través del 

Servicio de Enlaces CSIC, con la posibilidad de obtener acceso off-

campus mediante el servicio PAPI 

Configuración 

manual 

Configuración por 

defecto 



¿Cómo disfrutar de esas 

ventajas?  

Si ya tiene creada una cuenta gratuita en Mendeley, puede 

unirse al Grupo Institucional del CSIC entrando en: 

• https://www.mendeley.com/groups/7006121/consejo-

superior-de-investigaciones-cientificas-

csic/?broadcast=1&siteCampaignId=joinInstitution%3Acsic1 

• Después, pulsar el botón Join this group y OK 
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¿Cómo disfrutar de esas 

ventajas?  

Si ya se dispone de una cuenta, pero con un correo distinto 

al institucional del CSIC, en el momento de pedir su 

adscripción al grupo CSIC tendrá que proporcionar a Mendeley 

un correo institucional del CSIC para que el sistema le permita 

unirse al grupo. Si lo desea, puede cambiar su correo en la 

cuenta de Mendeley pinchando en el desplegable junto al 

nombre y, a continuación, en "Settings > Account Settings". 

Si el correo usado es con dominio de la universidad (centros 

mixtos), podrá unirse al grupo solicitando a la responsable de 

MIE en URICI (Inmaculada Ramos, inma.ramos@bib.csic.es) 

una invitación para unirse al grupo. 

Si aún no tiene creada una cuenta en Mendeley, debe crearla 

antes para poder unirse al grupo CSIC.  
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¿Cómo crear una cuenta 

en Mendeley?  

• Acceder a: http://www.mendeley.com/  

• Pulsar en “Create a free account” 

• Introducir nombre y apellidos, correo electrónico (mejor el 

correo institucional del CSIC) y contraseña. 

• Al reconocer el correo institucional del CSIC,  Mendeley 

ofrece de forma automática la posibilidad de unirse al Grupo 

Institucional del CSIC y disfrutar de las ventajas de 

Mendeley Institutional Edition. 

• El usuario debe confirmar que quiere unirse al grupo. 

http://www.mendeley.com/
http://www.mendeley.com/groups/7006121/consejo-superior-de-investigaciones-cientificas/
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¿Cómo crear una cuenta 

en Mendeley?  



Mendeley Desktop 

(versión escritorio) 

Descargar la aplicación (https://www.mendeley.com/download-

mendeley-desktop/), para instalar en nuestro ordenador, 

seleccionando la versión correspondiente a nuestro sistema 

operativo. 

 

 

 



Mendeley Desktop 

(versión escritorio) 

Estructura en tres columnas 

 

«My 

Library»: 

Organizar 

los 

documentos 

y aplicar 

filtros 
Panel de contenido de 

documentos o referencias 

Detalles del 

documento 

seleccionado 

(se pueden 

añadir 

etiquetas y 

notas) 

Visualización documentos en forma de cita o tabla  



Mendeley Web 

 

 

 

 

  

1 2 3 



Mendeley Web 
 

          

          Actualizar nuestro perfil y configurar temas de privacidad, 

notificaciones, etc . 

 

        Panel de pestañas: 

    - Feed: Conocer las actualizaciones de nuestros contactos. 

    - Library: Acceso y gestión de los documentos de nuestra Biblioteca 

    - Groups: Crear grupos (“Create a new group”). Acceder a grupos a los que 

pertenezcamos. Buscar grupos y  ver las referencias y miembros que los forman y,  

unirnos “Join this group” o seguirlos “Follow this group”. 

    - Suggest : Sugiere documentos relacionados con nuestra Biblioteca y añadidos 

más recientemente, etc. 

    - Stats: versión Beta, estadísticas de nuestras publicaciones en Scopus. 
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Mendeley Web 

 

      - Data: Permite publicar datos de investigación, compartirlos, y ponerlos a 

disposición de otros investigadores. Proporciona un “DOI versionado” que vincula los 

datos con webs, como ScienceDirect o CellPress, para poder ver el artículo y todo el 

conjunto de datos de investigación vinculados a ese artículo. También se pueden 

compartir datos no publicados de manera privada. Los conjuntos de datos están bajo 

licencias abiertas y se archivan permanentemente en DANS (Data Archive and 

Networking Services)  

 

          Búsqueda “Search”  

    - Papers: Buscar en todo el catálogo de Mendeley, desde el cajetín de búsqueda 

y navegar por los índices de materias. 

    - Groups: Buscar grupos y ver las referencias y miembros que los forman 

    - People: Localizar  investigadores a los que seguir “Follow” o contactar “Send 

message”.  
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Mendeley Web 

 Mi Perfil 

Datos estadísticos 



Mendeley Web 

Biblioteca Personal “My Library”  Añadir 

docs 

Organizar 

docs 

Borrar 

docs 

Crear carpetas 

Crear grupos 

Completar

docs 

Organizar 

docs 



Trabajar con Mendeley 

          

         Creando tu Biblioteca 

 

         Gestionando tus referencias y documentos 

 

         Citando y creando bibliografías 

 

         Trabajando en grupo 

 

1 

2 

3 

4 



        Creando tu Biblioteca 

1. Importar referencias 

 

Manualmente 

Desde el ordenador 

Desde Bases de Datos con Web Importer 

Desde Bases de Datos incompatibles con Web Importer 

Desde el catálogo de Mendeley 

Desde otros gestores 
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       Creando tu Biblioteca 

Manualmente 
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       Creando tu Biblioteca 

Desde el ordenador 
 

Pdfs de forma individual 

Carpeta completa 

«Watch Folder» 
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       Creando tu Biblioteca 

Pdfs de forma individual 
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        Creando tu Biblioteca 

Carpeta completa con posibilidad de subcarpetas 
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       Creando tu Biblioteca 

Watch Folder          importación automática de los nuevos 

pdfs de carpetas configuradas para su chequeo 
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       Creando tu Biblioteca 

Desde Bases de Datos con Web Importer 

Sitios que lo soportan: https://www.mendeley.com/import/ 
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       Creando tu Biblioteca 

Desde Bases de Datos con Web Importer 

1º Instalación de la herramienta Web Importer  

“Tools”>“Install Web Importer” 
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       Creando tu Biblioteca 

2º Importar directamente los resultados de una búsqueda en 

una bases de datos que soporte “Web Importer”: 

Buscar         seleccionar        pinchar en “Save to Mendeley” 
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       Creando tu Biblioteca 

Nota: En ScienceDirect y Scopus al utilizar por primera vez, 

aparece el botón de exportación directa de Mendeley 
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       Creando tu Biblioteca 

Desde Bases de Datos incompatibles con 

Web Importer (formatos RIS y BibTex) 

 Formato RIS (Bases de datos Proquest) 
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        Creando tu Biblioteca 

Desde Bases de Datos incompatibles con 

Web Importer (formatos RIS y BibTex) 

 Formato BibTex (Bases de datos Web of Science) 
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       Creando tu Biblioteca 

Desde el catálogo de Mendeley 

 Escritorio: «Literature Research» 
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       Creando tu Biblioteca 

Desde el catálogo de Mendeley 

 Web: «Papers» 
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       Creando tu Biblioteca 

Desde el catálogo de Mendeley 

 Herramienta «Related»: Añadir referencias de la misma forma 

1            



        Creando tu Biblioteca 

Desde el catálogo de Mendeley 

 Herramienta «Mendeley Suggest»: De momento sólo 

disponible desde la Web 

1            



       Creando tu Biblioteca 

Desde otros gestores 

Desde la pantalla de bienvenida o volviendo a abrirla desde 

el escritorio: “Help”>“Show the welcome screen” 

 

1            

XML, BibTeX, 

o formato RIS 



        Creando tu Biblioteca 

2. Exportar referencias 

Seleccionar referencias            pinchar “File”>“Export” 

 

 

 

1            



       Creando tu Biblioteca 

3. Sincronizar (Web              Escritorio o local) 

“Sync” o “File”>”Synchronize Library” 
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Gestionando tus 

   documentos y referencias 

1. Crear y organizar capetas 

 

 

2           



Gestionando tus 

   documentos y referencias 

2. Marca de Leído/No leído y Favoritos 

 

 

Favoritos 

Leído/No leído 
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   Gestionando tus 

documentos y referencias 

3. Ver y ordenar referencias 

 

 Ordenar 
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   Gestionando tus 

documentos y referencias 

4. Revisar las referencias       corregir o completar 

 

 

 

 

 

 

 

 

Nota: Al importar, si el sistema detecta que las referencias 

están incompletas crea una carpeta “Needs Review” 
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Gestionando tus 

documentos y referencias 

5. Buscar 
- Mediante el buscador ”Search” 

 

 

 

 
- Mediante diferentes filtros ”Filter by” 

 

 

 

 

 

2           



Gestionando tus 

documentos y referencias 

6. Duplicados 

“Tools”>”Check for Duplicates”>”Confirm Merge” 

 

 

 

 

 

 

 

 

Nota: Si no aparecen marcados los campos, dos o más campos no 

tienen la misma información y hay que comprobar que son 

duplicados 

  

 

 

 

 

1 

2 

3 
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Gestionando tus 

documentos y referencias 

7. Anotaciones en los pdfs 
– Subrayar textos “Highlight Text” 

– Anotaciones tipo post-it “Add Note” 

 

 

 

 

 

 

 

Nota 1: Deberán hacerse abriendo el pdf dentro del grupo para que se 

compartan en los grupos y sólo en los privados 

Nota 2: Crear un nuevo pdf con los cambios “File”>”Export pdf with 

Annotations”. 
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Gestionando tus 

documentos y referencias 

8. Organizador de referencias o documentos 
– “Organize my files”         copia en una carpeta todos los documentos 

de la Biblioteca 

– “Sort files into subfolders”          crea una estructura de carpetas 

según detalles de los documentos 

– “Rename document files”         renombra los documentos 

incluyendo autor, revista, título y año 

  

 

 

 

 

 

 

 

 

Nota 1: Deberán hacerse abriendo el pdf dentro del grupo 

Nota 2: Crear un nuevo pdf con los cambios “File”>”Export pdf 

with Annotations”. 
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Citando y creando 

bibliografías 

Mendeley dispone de un número elevado de estilos de citas (7.000) 

”View”>”Citation Style” 

”More Styles”            Para instalar cuando no aparece en el listado 

”Edit Style”             Para crear uno propio o editar uno existente 
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Citando y creando 

bibliografías 

 

1º Instalar el plugin para Word: ”Tools”>”Install MS Word 

Plugin” (aparecerá en nuestro word, en la pestaña 

”Referencias,” el bloque perteneciente a Mendeley)  
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Citando y creando 

bibliografías 

– Insertar citas: ”Insert Citation”>”OK”  
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Citando y creando 

bibliografías 

 

– Crear Bibliografías: ”Insert Bibliography”  
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      Trabajando en grupo 

 

– Buscar grupos de trabajo públicos: Pestaña ”Groups” 

en Mendeley web (directamente o a través de listados de 

disciplinas 
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    Trabajando en grupo 

 

– Unirse o seguir a un grupo de trabajo público: ”Join 

group” o ”Follow group” en Mendeley web (directamente 

o a través de listados de disciplinas 
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      Trabajando en grupo 

 

– Crear grupos de trabajo:  

 

Privados: Sólo se puede pertenecer por invitación. 

Contenido visible sólo para los miembros 

Públicos con invitación: Visibles para todos, pero a 

su contenido sólo pueden contribuir los miembros 

Públicos abiertos: Cualquiera puede unirse y 

contribuir en ellos 
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      Trabajando en grupo 

 

– Crear grupos de trabajo 

1. Desde el escritorio: 
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Detalles 

del grupo 



      Trabajando en grupo 

 

– Crear grupos de trabajo 

2. Desde la web: 
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Detalles 

del grupo 



      Trabajando en grupo 

 

– Dentro de un grupo de trabajo veremos 3 pestañas: 
1) “Overview”: Información de qué está ocurriendo en el grupo 

2) “Documents” o “Papers”: Ver los documentos del grupo y añadir nuevos  

3) “Members”: Ver los miembros que componen el grupo y añadir a otros 

contactos nuestros en Mendeley  (“Add” o “Invite”). 
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Mendeley escritorio 

Mendeley web 



 

Gracias por vuestra atención 

(inma.ramos@bib.csic.es) 

 


